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Binary App Installation — Local

fﬂ Unsaved Project - Workbench

" Installing from the Extensions menu: e e
1. From the Extensions menu, select the “/nstall Extension...” option 5| |8 T ero BE AcTstartpage

4 ] Impart... Reconnect |+ % Manage Extensions... B 5 ACT Start Page

2. It will open a file dialog to select the appropriate “*.wbex” binary file Toobox
. . . e Build Binary Extension. ..
3. Click “Open” to install the extension |§;Eiim:ﬁ:::fknng e
E:iz'll-:calueBuckling(Samce B ViewlogFie
" Loading the extension: i -
1. From the Extension menu, select the “Manage Extensions...” option < | OHLIXTITE AP -
Organize = =~ 0 @
2. Tick the box that corresponds to the installed app and click Close pr— N oo
P Desktop Local Disk (C:)
- S
Data (D3)
4 Libraries s V .T of 499 GB
8 Dociments Scratch (E)
) Music - —
& Pictures V7 720 GB free of 326 GB
B videos Devices with Removable Storage (1)
4% Computer &
[ concer |

Notes: %AppData% = C:\Users\username\AppData\Roaming

* The extension to be installed will be stored in the following location:
%AppData%\Ansys\[version]\ACT\extensions (Example for [version]: v232)

* The installation will create a folder in this location, in addition to the .wbex file
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License Client Installation - Local

" First time install: When the app starts, a pop-up window will ask for two inputs:

" Type the hostname of your EDRMedeso/CADFEM License Server
®= Manually fill in the server name and hit Enter. Can not be left blank. .
" FlexLM port number (recommended 27100)

" Here you type the port number to use and hit Enter.
If you leave it blank and hit Enter, 27100 will be used by default.

The hostname and port number are saved in the license.ini file located in S
%AppData%\EDRMedeso_Apps\Shared Files\

ppppppppp

B CA\WINDOWS\system32\cmd.exe - [m] x
Type the hostname of your EDRMedeso/CADFEM License Server: NameOfYourLicenseServer
FlexLM port number (recommended 27100): 27100,
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License Server Test — Local .

ion Automation Baolt Toolkit ANSYS Cloud

" To test that the installation was successful, BB T i S eH 3 OF

= Bolt Bolt Contacts  Rivet Bolt Group Simplified Advanced Mesh Bolt Open Open
I14 ] 7 - facts Match Group Pretension Bolts Group Bolts Group Results~  Report Preferences™ Do -
run the “Check License Status” function from
QA |Bw& "z C-h QA QG Select ®kModer ITTRERERRERME V™ E | ER ChekoutLicense end~ 9 SelectBy~ - Convert~

B Checkln License

the licensing tab. B e

BN C\WINDOWS\system32\cmd.exe - [m] x

" The apps are now ready to be used! I SR

status on Tue 18/5/2821 14:36

ADFEM FlexLM License Server\b
erver UP (MASTER) v11.14.1
ndor daemon status (on license):

cadfmlmd: UP v11.14.1
Feature us, info:

Users of edrmedeso_bolttoolkit: (Total of 999 licenses i ; Total of 1 license in

"edrmedeso_bolttoolkit™ v28622.6630, vendor: cadfmlmd, expiry: 1-jan-8
floating license

Users of edrmedeso_reportgenerator: (Total of 999 licenses issued tal of 1 license in use)

“edrmedeso_reportgenerator” v2 8630, vendor: cadfmlmd, ex
floating license

Users of edrmedeso_weldfat: : (Total of licenses issued; Total of @ licenses in use)
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EDRMedeso licensing features £ X &1 ==

" Projects using the EDRMedeso license feature has several benefits compared to the Ansys app license.

" You may open a Workbench project without the app license being checked out.

" You may also open Mechanical without the app license being checked out.
(This allows the model to be shared with people without access to the app or license.
Just make sure to “Save Binary Extension with Project”, see “WB>Tools>Options...>Extensions” below.)

®" You may activate the app license to reserve it for your continuous use. “Check Out License”

" You may release the app license from the current Mechanical session to use it in another session within
the same project or a different project or by a different user. “Check In License”

®" You may check the status of available licenses and who is using the license. “Check License Status”
®" The app license is automatically checked out when evaluating a feature during solve or post processing.
" |f the license is not available a warning message is displayed in Mechanical.

1y A options - O *
Weld Fatigue

|

ve Cumulative
thod Damage

Z Q&

Cpen Open Licensing

Preference Doc

-

- Project Management

- Appearance

- Regional and Language Options
- Graphics Interaction

- Journals and Logs

Extensions

General Options

Additional Extension Folders (enter folders separated by ;)

Q(:} Initiate Licensing - Project Reporting |
Q | bl DE | G- € % Check Out License ;;!IJUD.I'IPI'DCSS Save Binary Extensions with Project
- Extensions
% s s - Mechanical APDL Mever bl
ﬁ Check License Status H- Design Exploration Nevgr )
l - Distributed Compute Services [m&' ied but locked to the project

- Rennsitnng
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Licensing for Node locked License

®" Node locked means that the license is bound to the machine which is specified in the license
file “license.lic”. The license can only be used on this machine.

" The license file “license.lic” has to be located in (copied to) the following directory:
%AppData%\EDRMedeso _Apps\Shared Files\
and replaces the file “license.ini” that must be deleted (or renamed)

® Remarks:

" Does not require a CADFEM FlexLM license server

® The name of the license file must be “license.lic”

Shared Files X
@ New T Sort = view
€ - I » ThisPC » 0OS(C) » Users >- > AppData » Roaming » EDRMedeso_Apps » Shared Files »

-

™ Home Name Date modified Type Size

bin 2023-09-1415:36 File folder
[} license.ini.old 2023-09-1415:36 OLD File KB
2023-09-14 15:24 LIC File KB
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Multi-user deployment of apps - Network

®  Once the binary extension is installed at default location, one can move the *.wbex and the folder to any other location

= Default path: %0AppData%\Ansys\v201\ACT\extensions
® New path: Any location on your machine, shared drive etc.

= All users interested in using the extension need to include that path in their Workbench Options

1. Inthe “Tools” menu, select the “Options...”
2 . gOptiDns — O b

Select “Extensions”in the pop-up panel
3. Add the path under “Additional Extensions Folders”

x WeldFatigue_V201.8 - Workbench

-~ Project Management -
- Appearance

- Regional and Language Options

- Graphics Interaction

- Journals and Logs J | Additional Extension Folders (enter folders separated by ;) 3
- Project Reporting o \lshare_name'\EDRMedeso_Apps'\v201

General Options

- Solution Process - - - -
File  view [NE8 Units Extensions Jobs He - T — 2 Save Binary Extensions with Project
- Mechanical APDL Mever il
J ._3 H Reconnect - CFX
] = i Design Explaration Development
.ﬁj Import... Refresh Project - Distributed Compute Senvices
. Fluent ¥ Debug Mode

- Material Designer

I #  Update Project
E Analysis Sy, License Preferences... M:;hia:;ca

Define additional folders in which ACT

(B Coupledi  Release Reserved Licenses... e will search for extensions in order to
g ;zz:jg':T_ 1 e e e . expose them in the Extension Manager
i L T

Restore Defauls 0K | | Cancel

Notes: %AppData% = C:\Users\username\AppData\Roaming
+ During the scan of the available extensions, the folders will be analyzed according to the following order:

1. The application data folder(e.g %AppData%)\Ansys\[version)\ACT\extensions)

2. The additional folders defined in the “Additional Extension Folders” property

3. The installation folder

4. The “extensions” folder part of the current Workbench project (if the project was previously saved with the extension)
« If an extension is available in more than one of these locations, the 15t one according to the scan order is used
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App version control - Network - booan
® The Local and Network install has some pros and cons to be aware of. PRS-

In both cases you may have several app versions installed at the same time for each Ansys version so you may |~ .
select when to upgrade a project to a newer app version. . Destiop

%] Documents

‘Downloads
® Local Install: B s
+ The app is only available in an Ansys version if it is installed by the user. e

- Each user must install the app for every Ansys release and use correct app installer file (*.wbex).

- If an app version should not be used each user must un-install it and replace with a newer version.

« v 4 L Network »
= Network Install: aorton )
. . - . . ¥ 3D Objects
+ All apps are available to all users if the extension path is set to the correct shared folder, see previous page. mow
Each Ansys version may use a different version specific folder (v201) as well as a common folder (v20X). & oo
D Music
+ If an app version should not be used the administrator may remove an app in the shared folder and replace |, . ...
with a newer version. @ OneDive-Pesanl °
[ This PC
- Requires network access to activate the app in a project. Note: you still need network access to check out a B o
license. e
4 Downloads
For network install it is recommended to follow the same folder structure as for local install. Use one folder for each Ansys version. v
The app installer name indicate the supported version, e.g., “Bolt Toolkit V201.14.wbex” is built for Ansys 2020R1 (v201). B videos
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n > AppData >

Local Install

~
Name

ansys18.2
ansys19.2
ansys19.3
ansys19.4
ansys19.5
ansys20.1
ansys20.2
EKM
v182
v192
v193
v194
v195
v201
v202

Network Install

» EDRMedeso_Apps >

Mame

Shared Files
19X
v20X
v1g4
v195
v201
v202

> EDRMedesa Apps > v201 »

MName

ANSYSMotion
Bolt Toolkit V201.14
Report Generator V201,12
Report Generator V201.13
Rescale
Weld Fatigue V201.8
Weld Fatigue V201.9
Weld Strength V201,13
Weld Strength V201,14
| ] ANSYSMotion.whex
|| Bolt Toolkit V201.14.whex
| | Report Generator V201.12.whex
[ Report Generator V201.13.whex
[ Rescale.wbex
[ Weld Fatigue V201.8.wbex
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License Client Installation — Network

" After installing the binary app as described on the previous pages the license
client “Shared Files” folder must be copied to the network location.

" | ocate the “%AppData%\EDRMedeso_Apps\Shared Files\” folder and copy/paste
It to the selected shared drive, e.g. \\share_name\EDRMedeso_Apps.

€ o v

5+ Quick access
@ OneDrive - EDR & Medeso AB
@ OneDrive - Personal

[ This PC
J 3D Objects

edrmedeso.com

> AppData »

|

Shared Files

Reoaming »

EDRMedeso_Apps »

« “ P L s Network »

3+ Quick access
@ OneDrive - EDR & Medeso AB
@ OneDrive - Personal

~ [ This PC
J 3D Objects
[ Desktep
=] Documents

; Downloads

» EDRMedeso_Apps »

-

MName

Shared Files
v19X
w20
w21X
w194
v195
w201
w202
w211
v212
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Setting the Environment Variable - Network

" The app will try to locate the “Shared Files\bin” folder and save an environment variable.
If the folder is not found, the installation path will be %AppData%\EDRMedeso_Apps\ by default (recommended).

" The location of the license client ‘EDRMedeso_Apps\Shared Files\bin” is saved in the “User variables”. To define the
variable for all users on a machine you may edit the “System variables”

= Define a new Environment Variable named “EDRMedeso_InstallDir” and browse to the “bin” folder located in the
network folder, e.g., A\share_name\EDRMedeso_Apps\Shared Files\bin”

System Properties * /i r
Computer Name Hardware Advanced  System Protection Remote -
Browse For Folder x
You must be logged on as an Administrator to make most of these changes.
Peformance Varizble name: 11 | EDRMedeso_InstallDir
Visual effects, processor scheduling, memory usage, and virtual memory . .
Variable value: | v Roamin g
Settings... Browse File...
User Profiles
Desktop settings related to your sign-n L\\,
System variabl
Settings...
Variable Value M EDRMedeso_Apps
g Shared Files
Startup and Recovery i
System startup, system failure, and debugging information
Settings... Folder: | bin
Make New Folder 3 Cancel
Environment Variables... T = — T —T
New... Edit... Delete
oK Cancel Apply 4 Cancel
edrmedeso.com
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Edit license.ini file - Network

® The name of the EDRMedeso/CADFEM license server is defined in the file “license.ini” located in the
‘EDRMedeso_Apps\Shared Files” folder (as described earlier).

= Edit the first line so it matches your “license.lic” file containing your app license features.
‘host_name”. Hostname of the EDRMedeso/CADFEM license server in your network
‘host_id”: Mac address of your license server (not necessary, 000 can be used)

< Local Disk (C:) » Users » > AppData » Roaming » EDRMedeso_Apps # Shared Files » v O
~ MName Date modified Type Size
bin 2020-06-22 11:39 File folder
| license.ini 2020-06-22 10:08 Cenfiguration sett...
Ié{' *C\Users) MAppData\Roaming\EDRMedeso_Apps\Shared Files\license.ini - Notepad++ — O x
File Edit 5Search View Encoding Language Settings Macro Run  TedFX Plugins Window 7 X
cEHEHBRHE shh2¢ gl ax BRF (=1 EEH|® BRE =avz "

[ licenseini I
SERVER host name hOSt_id 27100
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Thank You!

Magnus Gustafsson
magnus.gustafsson@edrmedeso.com
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